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Objectives

* |dentify desktop publishing features
* Create a title with WordArt

* Create newspaper-style columns

* |nsert and edit graphics

 Wrap text around a graphic
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Objectives

* |[ncorporate drop caps

* Use symbols and special typographic characters
 Add a page border

* Perform a mail merge

* Create a blog post
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Elements of Desktop Publishing

* Desktop publishing is the process of preparing
commercial-quality printed material using a
desktop computer system

— Page layout

— Graphics

— Multiple Fonts

— High-quality printing

New Perspectives on Microsoft Office Word 2007

Shepherd Bay Medical Center newsletter

headline =

Preventing Type Ii Diabetes

Nealthy Living!

office. Hop off the bus ane stop earlier than

[Grapcap]

labetes is the
body falls to produce or property
use insulin, We need insulin to

convert food into the energy we expend

‘each day. Over 20 million Americans suffer
from this very serious disease. Between 5
and 10% of these 20 million diabetes
sufferers have type 1 diabetes. Mast type 1
diabetics are children and young aduls. So
far, we know of no way 0 prevent the
onset of type 1 diabetes. However, the
mere common variety, type 2 diabetes, can
be delayed or prevented—if you act in time.
The secrets to preventing type 2 diabetes.
are a healthy diet and regular exercise.

usual, an extra block

Eatsmart
he Arverican Disbetes Assocition
weight can greatly reduce your risk

oftype 2 disbates. A

heathy diet

‘combined with

daily exercise
makes it easy 1o lose —
that §%. Remember, a healthy diet includes.
lots of fresh fruits and vegetables, whole
grains, nonfat dairy products, beans, lean
meats, poultry, and fish

clip art
graphic

Get Moving

‘adults get at least 30 minutes of
physical activity five days a week. If
You are among the 60% of Americans who
fail 10 get this minimum amount, it’s time to
et moving. Start by making some easy
changes in your daily life. Opt for the stairs
instead of the elevator on your way Into the

I recommends that

Risk Assessment

very Monday, Shepherd Bay Medical

ssessments, We'll check your blood
e and weight and help you fill out
h questionnaire. Your results will be
2ed by Healthuife®, a computer
program designed in conjunction with
‘Shepherd Bay researcher Student Name.
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Creating WordArt

Click the Insert tab, and then, in the Text group, click the WordArt
button

In the WordArt gallery, click the style of text you want to insert
Type the text you want in the Edit WordArt Text dialog box

Click the Font and Size arrows to select the font and font size you
want. If you want, click the Bold or Italic button, or both

Click the OK button

Use the tools on the WordArt Tools Format tab to format the
WordArt

Drag any handle to resize and reshape the WordArt. To avoid
altering the WordArt’s proportions, press and hold down the Ctrl
key while you drag a handle
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Creating WordArt

WordArt gallery
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* PreventingType-dl-Diabetesy ¥

Diabetes-is-a-disease-in-which-the-body-failsto-produce-or-{ M ; L]
toconvert-foed-into-the-energy-we-expend-each-day.-Over =

very-serious-disease.-Between-5-and-10%-of these-20-million-d
diabetes.-Most-type-1-diabetics-are-children- and-young-adults.
prevent-the-onset-of type- 1-diabetes.-However, the-more-comi

Tiabetes,-can-
be-delayed-or-prevented—if- you-act-in-time.-The- secrets-to-preventing-type-2-diabetes-are-a-
healthy-diet-and-regular-exercise.q

= Get-MovingT
The-surgeon-general-recommends-that-adults- get-at-least-30-minutes: of physical- activity-five:
days-aweek.-If you-are-among-the-60%-of Americans- who-failta-get-this-minimum- amount,-it’s-
time-to-get-moving.-Start-by-making:some-easy-changes-in-your-daily-life.-Opt-forthe-stairs-
instead-of the-elevator-on-your-way-into-the-office.- Hop-offthe-bus-one-stop-earlier-than-usual,-
sayou-have-to-walk-an-extra-block.q

Edit WordArt Text dialog box

o |

* EatSmarty
The-American-Diabetes-Association-says:losing-just-5%-of-your-body-we

| Edit Wordért Ted

Pagelofl | Words: 209 | B | Eont: Size:
"&Impact F” 36 ME]@
Text:
|
you will replace this text
‘ with the newsletter headline
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reating WordArt

WordArt inserted into document Figure 4
o) d9-0 ¢ Prevention Mewsletter - Microsoft Word | Wordart Taols - 8°X
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toconvert-food-into-the-energy-we-expend: each-day.-Over-20-million-Americans: suffer-from-this-
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Editing a WordArt Object

 To edit WordArt, it must be selected

* You can make changes using the tools on the
WordArt Tools Format tab or by dragging its
sizing handles

Figure 4-5 Edited WordArt headline
() d92-0 )= Prevention Newsletter - Microsoft Word Wordart Tools STETR
= Insert Page Layout References Mailings Review View = Forma t '@
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........................................................................... sPreventingType-l-Diabetesy
Diabetes-is-a-disease-in-which-the-body-failsto-produce-or-properly-use-insulin.- We-need-insulin-
to-convert-food-intothe-energy-we-expend- each-day.-Over-20-million-Americans- suffer-from-this-
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Changing the Shape
of a WordArt Object

Selecting a new WordArt shape
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Wrapping Text Below
a WordArt Object

* Inline graphic vs. floating graphic
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Positioning and Sizing
the WordArt Object

* You can adjust its position in the document by
dragging it with the mouse pointer

* To change the size of a WordArt object, drag one
of its sizing handles

— To keep the headline the same proportion as the

original, hold down the CtrI key as you drag the sizing
handle : -
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Anchoring the WordArt Object

to a Blank Paragraph

* To prevent the column format from affecting the
WordArt object, you need to anchor it to its own,
blank paragraph

* |nsert a new paragraph
* Click the WordArt object

* Click the anchor and drag it up to position it to
the left of, and just above, the new, blank
paragraph
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Anchoring the WordArt Object
to a Blank Paragraph

Properly anchored WordArt Figure 4-10
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Formatting Text

in Newspaper-Style Columns

* |[n newspaper-style columns, a page is divided
into two or more vertical blocks, or columns

* Click the Page Layout tab, and then, in the Page

Setup group, click the Columns button
Correct settings in Columns dialog box

.-Columns @
Presets
Cne W Th Left Right

Mumber of col 2 | Line between

Width and spacing revien places a Iine

ol s 2paang: between columns
i) Hoes B

creates columns =1

shows how columns will
look with current settings

MDA
L
n

of the same width F :
|¥] Equal colurmn width

adds a section break | appiy to; |T| [ start new column
at the insertion point

New Perspectives on Microsoft Office Word 2007 14



Formatting Text
in Newspaper-Style Columns

Document formatted in two columns
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Inserting Graphics

* The term graphic can refer to a drawing, a
photograph, clip art, a chart, and so on

e PiCtu re button Clip Art task pane
— Clip Art button = e R o
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options to
search for |
a graphic
Quick Parts ¥ to a
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click to browse among
the images stored on
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9 Op arton Dffice Onine

New Perspectives on Microsoft Office Word 2007 16




Inserting Graphics
Selected image in Food folder
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Resizing a Graphic

* You can resize a graphic either by dragging its
sizing handles or, for more precise control, by
specifying an exact height and width in the Size

group on the Picture Tools Format tab
Resizing the graphic
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Cropping a Graphic

* You can crop a graphic using the Crop button on
the Picture Tools Format tab

Croppin the raphic
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rapping Text Around a Graphic

Text wrapped around the graphic
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Moving and Aligning a Graphic

* You can move a graphic by dragging it

* Like WordArt, a clip art graphic is anchored to a
specific paragraph in a document
— When you drag a graphic to a new paragraph, the

anchor symbol moves to the beginning of that
paragraph

— When you drag a graphic to a new position within the
same paragraph, the anchor symbol remains in its |
original position and only the graphic moves
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oving and Aligning a Graphic
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Inserting Drop Caps

 Adrop cap is a large, capital letter that begins
the text of a paragraph, chapter, or some other
document section
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Inserting Symbols

and Special Characters

* |n printed publications, it is customary to change
some of the characters available on the standard
keyboard into more polished-looking characters
called typographic characters

Common typographic characters Figure 4-22

To insert this symbol or Type After you press the space-
character bar, Word converts to

em dash word--word word—word

Smiley 9 ©

Copyright symbol (c) ©

Trademark symbol (tm)

Ordinal numbers 1st, 2nd, 3rd, etc. T 20 5 che

Fractions 1/2, 1/4 o, Va

Arrows --> or <-- —or —>
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Inserting Symbols

and Special Characters

* Move the insertion point to the location where you want
to insert a particular symbol or special character

e Click the Insert tab, and then, in the Symbols group, click
the Symbol button

* |f you see the symbol or character you want in the Symbol
gallery, click it. For a more extensive set of choices, click
More Symbols to open the Symbol dialog box

* |n the Symbol dialog box, locate the symbol or character
you want on either the Symbols tab or the Special
Characters tab

* Click the symbol or special character you want, click the
Insert button, and then click the Close button
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Inserting Symbols
and Special Characters
Symbol dialog box
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Balancing the Columns

* Move the insertion point to the end of the text in
the right column

* Click the Page Layout tab, and then, in the Page
Setup group, click the Breaks button

 Below “Section Breaks,” click Continuous
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Balancing the Columns

Newsletter with balanced columns
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Inserting a Border Around a Page

 Use the Page Borders button on the Page Layout
tab to open the Borders and Shading dialog box
Adding a border to the newsletter

[ g B
use to add a e use to add a ——
border around a reler colored
selected paragraph cetting Syl background

e Click on diagram below ar use
No buttors to apply borders
- T El _ _
select this type

] Box —_——

of border
D EthDW I
select this |~
line style
H Avtamzti [
Nidth: apply to whole
ﬂ Custom 3ot —— Aoy to: document
whole document - E I
one) E =
Options. ..
[ QK ] [ Cancel ]
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Inserting a Border Around a Page

Border and Shading Options dialog box Figure 4-26

Border and Shading Qptiens @
i default settings wh
- ot [ efault settings wnen

4k 4k

= . “Text” is selected in

Bottom: |1pt Right: [4pt the Measure from box
positions border relative | | veasure from:
to the text (not the edge | —w-ic=rmmmmm ~ |
ﬂf thE Pagej Optons

[T] align paragraph borders and table edges with page border
don’t change Always display in front

- T

these sett]ngs Surround header

Surround footer

Preview

Qb ] [ Cancel
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Inserting a Border Around a Page

Newsletter with border
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Performing a Simple Mail Merge

* The term mail merge refers to the process of
combining information from two separate
documents to create many final documents,
each containing customized information

— A Main document contains text and place holders
called merge fields

— Merge fields tell Word where to insert customized
information
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Performing a Simple Mail Merge

June 26, 2010

[INSERT ADDRESS FIELDS]

Dear [INSERT FIRST NAME FIELD]:

Enclosed you will find an informational newsletter published by Shepherd Bay Medical Center. We
would like to make this a regular publication that focuses on health-related topics. To ensure that it is as
helpful as possible, we are soliciting feedback from potential readers. Would you have a moment to give
me your opinion regarding the newsletter’s content and layout? My office is located at the South Clinic.
You can reach me everyday from noon to 5 P.M. at 555-5555.

Sinceraly,

Joel Conchola

Public Qutreach Specialist

Joel’s data source Figure 4-29

a merge header row includes
field name all merge field names
for this data source :I
First Name Last Name | Street Address City State | ZIP
Rhoda Carey 3545 Route 14 Brandon | MS 39875
Marley Delisle 1234 E. Pascagoula Jackson MS 39204
record for |  I'coiperin Larke 36 CapersAvenue  lJackson [Ms 39211
|r||_dmdual L[ Tuca Peters 3453 River Lane Richland [ ms [ 39345 |
client Daniel Shorba 4533 Terry Road Jackson | M5 39298
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Performing a Simple Mail Merge

Figure

(&)

Wo-u s

30 Mail Merge task pane

Cover Letter - Microsoft Word

e ey
Home  Insert Page Layout References Mailings | Review  View @
s _:'¢| L 3 s ) =B =5 ] P Rules - Q{ [ ||
— —-"I‘ - @ 4 ! < Match Fields #7]Find Recipient 5
Envelopes Labels @ Start Mail  Select Edit Highlight Address Greeting Insert Merge Preview | Finish &
Merge~ Recipients = Recipient List | Merge Fields Block Line Field - 2] Update Labels || pesyits ),/ Auto Check for Errors || perge -
Start Mail Merge Write & Insert Fields Preview Results Finish
] [ e Ml perge v x
. Select type
li n
C thOOPE What type of document are you
Start Mail working on?
Merge menu —
O E-mail messages
O Envelopes
q 1
O Drectory
1 Letters :
Send letters to & group of people.
L] You can personalize the letter
that each person receives.
q Click Next to continue.
June-26,-20109
.
1 \ you will replace
A
[INSERT-ADDRESS-FIELDS] text in brackets

with merge fields
1

Dear-{INSERT-FIRST-NAME-FIELD]:4]

Enclosed-you-will-find-an-informational-newsletter- published- by-Shepherd- Bay-Medical-Center.-We-

would-liketo-make-this-a-regular-publication-that-focuses: on-health-related-topics.- To-ensure-that-it]

helpful-aspossible,- we-are-soliciting feedback-from-potential- readers.-Would-you-have-a-moment-to|

me+your-opinion- regarding the-newsletter’s- content- and-layout?-My-office-is-located-at-the- South- Cl :
.

. P

Yy

Page:1ofl

Words: 96 |

first task
currently
displayed

Step1of 6
% Next: Starting document
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Selecting a Data Source

In the Mail Merge task pane, verify that the Use
an existing list option button is selected

* Click Browse in the Mail Merge task pane

Navigate to and open the desired data source
Mail Merge Recipients dialog box

Mail Merge Recipients 9| (o]
This is the st of recipie isiht iill be used in your merge., Use the Dtl hI ¢ to add to or change vour list. Use the
chackh eshn.:ddcrre ecipie tzfr the merge. When your list dy dick OK.

| Street_Address

1234 E. Pascegoula Jackson M3
36 Capers fAvenus Jackson MS
3453 River Lane Richland M5
4533 Temry Road Jackson  MS

A

+| table from Addresses
Data Source aefire renpient| dOcument displayed here
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Inserting Merge Fields

* Select the placeholders and use the Mail Merge
task pane to insert the appropriate fields

Address Block merge field in letter Figure 4-33
,/Ej H92-0 * Cover Letter - Microsoft Word - 8X
- me Insert Page Layout References Mailings | Review  View L7l
. [=) i - 2] =k ak - 2 Rutes - H 41 ] e
I 1 E j j j j 27, Mateh Fields %1 £Find Recipient s
Address Block merge | st Highlight  Address Greeting Insert Merge Preview Finish &
= 5 o Field = ] Update Labels || peguts | =3 Auto Check for Errors Merge
| field inserts entire  |.| ansled brackets  |weenre: Previcw Risiits Finish
[insideaddress in icatemergeﬁeld"':"'f"'f" s [ el Merge - %
June-26,20109 Write your letter
If you have not aiready done o,
q wirite your better now.
To add recipient information to
letter, dick in the
I i1 Acldlr 55 Bl oc ki fel——r! = - e e
still need to insert merge e
1 field in the salutation 8 Aodesbick .
4 Greeting ine...
Dear{INSERT-FIRST-NAME-FIELD]:q e
Enclosedyou-will-find-an-informational-newsletter- published: by-Shepherd- Bay-Medical-Center.-We- ke mlm:‘s
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Inserting Merge Fields

Figure 4-34 Insert Merge Field dialog box

i Inszrt Merge Figld

In=ert:
(™) address Felds i@ Database Fields
Figlds:

-
Last_Mame

Street_Address

City i

o space in merge

F field name replaced

with underline

merge fields
in data source

Match Fields. .. ] [ Irsert ] [ Cancel
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Previewing the Merged Document

* When you preview the merged document, you
see the main document with the customized
information inserted in place of the merge fields

* |In the Mail Merge task pane, click Next: Preview

your letters

)l 9~ v
-J/I Home Insert Page Layout
L] a"
S S e
Envelopes Start Mail  Select
Merge = Recipients = Reci
dd fo Start Mail Merge Preview Resu
fhe first : S | letter for recipient 1 |
: June-26,20109 is currently displayed letters
record in ged et
the data 1 > e
click to return 1
Rhoda-Carey to previously en

3545-Route-149]

too much space between
the lines of the address

displayed letter

Brandon,-MS-398751]

1
Dear-Rhoda:q J

first name for the first
record in the data source

click to preview
letters for other
recipients
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Merging the Main Document

and Data Source

* |n the Mail Merge task pane, click Next:
Complete the merge

* Click Edit individual letters in the Mail Merge
task pane

* Verify that the All option button is selected, click
the OK button, and then scroll as needed to
display the entire first letter
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Merging the Main Document
and Data Source
Newly merged document with customized letters

,...,...E.:...I RN AR N IR T
. I

1"

- June-26,- 20104

q
;‘2;2;53;:,1“&“ this letter is for the first
Brandon,-M5 398759 client in the data source
1"

Dear-Rhoda:q)

]TIEI'gEd Enclosed-you will-find-arinformational-newsl etter- published: by-Shepherd- Bay-Medical-Center.-We-

d ocument wiould liketo make-this-a-regularpublication-that-foc uses: on-health-related-topics. Toensure-that-it is-as:

Cﬂntain 5 ﬁVE helpful-aspossible,: we:aresoliciting-feedback-from potential readers.-Would: your have-a-momant- torgive-

pag'ES mesyour opinion regarding the news|etter's: content: and- layout ™ Myoffice iz located at-the - South: Clinic.-
r

You-canreach-me everyday-from-noon- ta-5-F_M_-at-555-5555_19]
one letter

s sreerele T the main document
“ remains open

section break separates
this letter from the next |

b Cialistioscasssimssasannssinssasssasszsssssasssseas:SECHON Brask (N2l PAQE) sassasssssassassaasszazsmsassssszasszassssas:

ver Letier - vecra.., T Lettersd - Microsoft .
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Creating a Blog Post

 Ablogis an online journal that other people can
read via the World Wide Web

* A blog post is an addition to a blog, similar to an
entry in a journal

e Start Word, if necessary
* Click the Office Button, and then click New

* Click New blog post and then click the Create
button

* Click Register Later
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Creating a Blog Post

Figure 4-39 Blank blog post
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